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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

  

 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 
Click in the Product Search box and type the number of this unit 
standard, as shown at the right. 

4 Click on     

5 Click on   

6 

Under the Exercise Files heading click on the underlined blue hyperlink, ie     

Book Exercise Files – 111 V7 / 107 V6 Word 2010  Free Download 

The File Download dialog box will display.   

7 If you have Winzip use the following instructions otherwise move to step 8. 

 a   Click on  .    

 
b   Click on the  of the  button. 

 c  If My Documents folder is not displayed click on Set default unzip folder at the bottom of 
the list.  Ensure My Documents is selected then click on Select Folder. 

 d    Click on the  of the  button and click on the My Documents folder.  The files will 
be unzipped. 

8 Click on and ensure My Documents folder is displayed.  Click on  

9 
Click on Open Folder which will display My Documents folder.  Right click on the zipped 
exercise file and select Extract All. Click on Extract.  A folder will be created containing the 
exercise files.   

US 111-107 

US 111-107 
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Changing Defaults 
Default settings may have already been changed in your Word 2010 program.  If not, you can use 
the following instructions to change these. 

Font and Font Size 
You can check if the font and font size have been changed by looking  at the Font box on the 
Home tab.  If it shows  then it has not been altered.  Change the default font to 
Arial 11 pt as follows: 

1 Click on the Font Dialog Box Launcher  which will display the 
Font dialog box. 

2 Change the Font: to Arial and the Size: to 11 pt. 

3 Click on . 

4 Ensure the following option is selected for the font to be applied to All documents based on 

the Normal template.  

 
5 Click on OK then on OK from the Font dialog box. 

Spacing 
Click on the Page Layout tab and if 10 pt Spacing After is displayed as shown at the 
right then this has not been altered.  Remove 10 pt spacing as follows. 

1 Click on the Paragraph Dialog Box Launcher  which will display the 
Paragraph dialog box.   

2 Change the Spacing After: to 0 pt as shown at the right.  

3 Click on .  Ensure All documents based on the Normal template is 
selected then click on OK.  Click on OK from the Paragraph dialog box. 

Margins 
Click on the Page Layout tab then click on the Page Setup Dialog Box Launcher 

 which will display the Page Setup dialog box.  If margins are 
displayed as 3.17 cm change them as follows.  (If they have been changed, click on Cancel.) 

1 The Top: margin will be selected, ie .  Type:  2.54 then press the Tab 
key.  Repeat this until the margins are displayed as shown below. 

. 

2 Click on .  Ensure All documents based on the Normal template is selected then 
click on OK.  Click on OK from the Paragraph dialog box. 
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 Unit Standard 111 Version 7 
 
 

Title Use a word processor to produce documents for a business or 
organisation 

Level 2 Credits 5 

 

Purpose People credited with this unit standard are able to: describe basic 
terminologies and techniques used for word processing; and use 
basic word processing to produce business or organisational 
documents. 

 

Classification Business Administration > Business Information Processing 

 

Available grade Achieved 

 
Explanatory notes 
 
1 All activities associated with this unit standard must comply with occupational 

health and safety guidelines and recommendations in relation to working 
environment and work practices.  Reference for this unit standard includes 
Guidelines for Using Computers. Occupational Safety and Health Service: 
Department of Labour, available at 
http://www.osh.dol.govt.nz/order/catalogue/computers.shtml. 

 
2 Logical structures such as folders must be used to organise and store files 

according to business or organisational requirements. 
 
Outcomes and evidence requirements 
 
Outcome 1 
 
Describe basic terminology and techniques used for word processing. 
 
Evidence requirements 
 
1.1 Basic terminology used for word processing is described in terms of function 

and use. 
 

Range basic terminology includes but is not limited to – document 
creation, naming, storing, retrieval, editing, formatting, 
previewing, printing. 
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vii 

1.2 Basic techniques used for word processing are described in terms of their 
function. 

 
Range basic techniques include but are not limited to – keyboard 

shortcuts, use of mouse; customising formats; manipulating text 
in accordance with the system requirements. 

 
Outcome 2 
 
Use basic word processing to produce business or organisational documents. 
 
Evidence requirements 
 
2.1 Use of keyboard shortcuts and mouse is in accordance with program features 

and requirements. 
 

Range evidence of six keyboard shortcuts and three uses of a mouse is 
required. 

 
2.2 Documents are produced, formatted, manipulated, saved and printed in 

accordance with information provided, and output required. 
 

Range documents must be of sufficient length and complexity to provide 
scope for the assessment evidence; 

 format includes – paragraph, page orientation, margins, 
tabulation, font selection, format painter; 
manipulation may include but is not limited to – move, copy, 
insert, delete, undo/redo, find and replace, set language, check 
spelling and grammar, customise dictionary; 
evidence of six manipulation techniques is required; 
save – name, save, save as a new file. 

 
2.3 System features are used to identify and manipulate screen display options 

and controls. 
 

Range features may include but are not limited to – maximise and 
minimise, page view, layout view, normal view, print preview, 
zoom %, ruler, ribbons, groups, tool bars, help; 
evidence of at least four features is required. 

 
2.4 Data security procedures and file management techniques are used according 

to the word processing program in use and business or organisational 
requirements. 

 
Range password protection of documents, rename file, locate files, 

backup files, external storage of documents, display folder 
contents. Sa
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Unit Standard 107 Version 6 
 
 

Title Apply text processing skills to produce communications in a 
business or organisational context 

Level 2 Credits 5 

 

Purpose People credited with this unit standard are able to apply text 
processing skills to produce communications in a business or 
organisational context. 

 

Classification Business Administration > Business Information Processing 

 

Available grade Achieved 

 
 
Explanatory notes 
 
1 All activities associated with this unit standard must comply with occupational 

health and safety guidelines and recommendations in relation to working 
environment and work practices.  Reference for this unit standard includes OSH 
3211 AFC: 1996 Approved Code of Practice for the use of Visual Display Units in 
the Place Of Work.  Occupational Safety and Health Service: Department of 
Labour, available at http://www.osh.govt.nz/order/catalogue/pdf/vdu-ac.pdf. 

 
2 Definition 
 Text processing conventions refer to accepted practices of display for page layout, 

use of white space, consistency, and spacing.  Conventions used must produce 
documents that are fit for their intended use and meet organisational style 
requirements. 

 
3 Evidence of text processing skills and editing must include the following features, 

which may be demonstrated once over all five communications rather than in each 
– amended text, deleted text, copied text, moved text, use of additional information, 
use of page and paragraph numbering. 

 
4 Spelling, grammar, vocabulary, and punctuation in the documents must be 

consistent with the nature and purpose of the business or organisational information 
required.  Candidates must be given the opportunity to proofread their work prior to 
submission. 
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Outcomes and evidence requirements 
 
Outcome 1 
 
Apply text processing skills to produce communications in a business or organisational 
context. 
 
Range: communications may include but are not limited to – essays, assignments, 

memoranda, correspondence, newsletters, reports, notices, advertisements, 
forms, email;  

 evidence is required for five different types of communication. 
 
Evidence requirements 
 
1.1 Spelling, grammar, vocabulary, and punctuation are consistent with the nature 

and purpose of the communications required. 
 
1.2 Page layout, format and display of communications are consistent with the 

output required, and meet organisational style requirements. 
 
1.3 Communications are composed from drafts and notes in accordance with 

information provided and output required. 
 
1.4 Use of words and figures is consistent with the nature and purpose of the 

communications required. 
 
1.5 Communications are produced in accordance with text processing 

conventions. 
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Exercise Files used in this book 
 

(Instructions are at the front of this book for downloading retrievable files from our web site.) 
 

 

Names of files 

Advertisements Health 

Africa History and Rules of Tennis 

Appliances Jacob and Sons – Sales Personnel 

Appliances-1 Jan Jasmine 

Balloon Gifts Layout Exercise 

Beads, Seeds and Shells Macroworks 

Body Shape Mobile Phone Specialists 

Brick Bay Sculpture Trail Owning a Cat 

Buying a Boat Owning a Dog 

Caring for your Carpet Pohutakawa Retreat and Sanctuary 

China Second-hand Shops 

Computer Wizz Limited Scuba Diving 

Cookery Book Supreme Packaging 

Cruises Supreme Property Service 

Cruising the Murray River Suzannah’s Cookery Book 

Educational Systems Tour de France 

Email Training Requirements-1 

Fabric Wholesalers Travelers 

Fiji Retrievable TRIATHLON-1 

Freezers What is an iPod 

Garden Designs Words and Figures 
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Ergonomics 
The Word 2010 Screen 
Create, Save, Open and Print Documents 
Cursor Movements, Document Views 

 
 
 

 

Learning Outcomes 
 
At the end of this section you should be able to -  
 

 Understand about ergonomics 

 Start and exit Word 2010 

 Identify parts of the Word 2010 screen 

 Understand the Ribbon and groups 

 Create, save, open, print and close documents 

 Practise cursor movements 

 Use the Zoom feature and Document View options 

 Minimize, Restore Down and Maximize a document  

Section 

1 

Sa
m

pl
e D

oc
um

en
t



2   SECTION 1 © Cherylprice.co.nz Limited     

 

Sa
m

pl
e D

oc
um

en
t



© Cherylprice.co.nz Limited SECTION 1    3 

What is Microsoft Word? 
Microsoft Word is a word processing program that allows you to create text and/or graphics using 
a keyboard which is displayed on screen (referred to as “soft copy).  The document is then saved 
onto the hard disk in your computer system.  A document can be opened on screen and edited and 
formatted (as many times as necessary).  A “hard copy” can be produced by sending the document 
to the printer. 

A word processing program generally includes the creation of - 

 General correspondence, eg letters, memos, faxes 
 Reports, travel documents, minutes of meetings, financial documents  
 Advertisements, flyers, brochures 
 Mail merges (ie direct mail), labels, tables 
 Manuals, other documentation 
 

The Process of a Word Processed Document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Final copy is printed 

(hard copy) 
 

Document is opened on screen.  It can 
then be edited and formatted, saved 

and resaved as many times  
as necessary. 

Document is printed 
(hard copy) 

 

  
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
As requested I am enclosing information on 
Elf Computer Systems.   
 
Please let me know if I can be of further 
assistance. 
 
Yours sincerely 
 
 
Sam Corinaldo 
Manager 
 
Encs 

Document is saved onto the 
Hard Disk inside the  

System Unit 

Text is displayed on monitor 
(soft copy) 

Text is copied from paper 
(or keyed in directly via the 

keyboard onto the  
computer monitor) 

 

  
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  
I aI am enclosing information as requested by 
you in your email.  Please ddo not hesitate to 
contact me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs 

 
 
 

 

System Unit 
Monitor 

Keyboard Mouse Speakers 

 Dk kfj k kdj kadj kd kadj fkad 
jkdj akljd jasd kaj kadj kadj kdj 
fkdjf kadj kadj kasdj lkasdj 
klasdj lkasdj lksdj fkasdj klsdj 
fksdj flksdj flkasdjf lksdj fkasdj 
fklasdj klasdj lkasdj lkadjf kadjf 
ak; 

  
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  
I aI am enclosing information as requested by 
you in your email.  Please ddo not hesitate to 
contact me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs 

 Dk kfj k kdj kadj kd kadj fkad 
jkdj akljd jasd kaj kadj kadj kdj 
fkdjf kadj kadj kasdj lkasdj 
klasdj lkasdj lksdj fkasdj klsdj 
fksdj flksdj flkasdjf lksdj fkasdj 
fklasdj klasdj lkasdj lkadjf kadjf 
ak; 
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What is Ergonomics? 
Ergonomics is the study of the efficiency, comfort and safety of people in their working 
environment.  In the office/computing sector, the field of ergonomics plays an important role in the 
production of monitors, keyboards and furniture, specifically in ensuring good design techniques 
that avoid the cause of backaches and muscle cramps.   

Learning how to sit at a desk and use your computer in an ergonomically sound manner will 
reduce the risk of health problems and ensure that you are comfortable in your working 
environment. 

The New Zealand Department of Labour has published an approved Code of Practice for the use 

of Visual Display Units covering all of the ergonomic factors that should be considered in a 
workplace.  This is available on the Resources tab of our web site at www.cherylprice.co.nz under 
the heading of Free Resources. 
 

 

 

Ergonomic Computer Equipment 

Monitor 

The monitor should be positioned so that it is straight in front of the operator, an 
arm‟s length (40cm - 90cm) away from the eyes.  The top of the viewing area of 
the screen should be just below eye level and the screen should be tilted so that the 
operator looks slightly downwards onto the screen.  The height of the monitor 
should be adjustable; this may require using a monitor stand to ensure it is at the 
correct height. 
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Anti-glare Screens and UV Filters 

Where a computer monitor is located near a window or lights, glare can commonly be a problem, 
causing eyestrain or headaches.  Many modern computer screens incorporate an anti-glare surface.  
For older computers, an anti-glare screen can be positioned over the monitor to reduce or eliminate 
the problem. 

Most anti-glare screens incorporate a filter which protects from ultra-violet (UV) radiation.  CRT 
monitors emit a small amount of UV radiation (and there is significant debate as to the danger or 
otherwise of this exposure).  LCD monitors do not emit a measurable amount of radiation. 
 
Copy-holder 

A copy-holder (also called a document holder) is used to position documents 
so they can be viewed easily while typing.  A well positioned copyholder 
reduces the need to bend the neck.  There are various types of copyholder; the 
most common are free standing devices which are positioned beside the 
computer screen.  Others can be attached to the side of the monitor. 
 
Keyboard 

While there are many different types of keyboard, all keyboards should have the following 
attributes: 

 They should be thin; the „asdf‟ row should be 30mm or less in height. 
 The slope should be between 0° and 15° and should be adjustable. 
 The keys should be sensitive enough so that they do not need to be hit hard. 
 They should make a clicking noise when the key is pressed successfully. 

 
 
To ensure the keyboard is correctly positioned on the workstation, place your hands over the 
centre of the keyboard and check the following: 

 Your forearms are parallel with the ground. 
 Your elbows are at a 90° angle (forming an L shape between the upper and lower arms). 
 Your fingers rest over the „asdf‟ row and all keys are able to be reached without stretching the 

fingers or forearms. 
 Your wrists are not raised or bent in an unnatural angle. 
 Your elbows are tucked in neatly by your sides. 
 Your fingers are curved in a natural position. 
 
Keyboard Wrist Rest 

The purpose of a wrist rest is to support the wrists in a natural, 
comfortable position.  This is an important ergonomic consideration 
for many people who experience pain or tiredness in their wrists 
when using a keyboard.  The wrist-rest is positioned in front of the 
keyboard.  Some keyboards have built-in wrist rests. 
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Mouse 

The mouse needs to be positioned so that the operator can move it without 
having to stretch their arm.  It should be placed on a flat surface such as a 
specifically designed mouse pad, which allows it to be moved easily. 

The mouse should be shaped so that the hand rests on it comfortably.  The 
buttons should be able to be used without cramping the hand.  The pressure 
required to click the buttons should not be so hard as to make it tiring to use, 
nor so light that they are easily clicked in error.  The mouse movement and 
click speed should be adjustable to suit the individual. 

Some mice are designed specifically with ergonomics in mind.  Wireless mice allow total freedom 
of movement.  Other mice are shaped specifically to fit the hand‟s natural shape and provide 
support. 
 
Mouse Wrist Rest 

In the same vein as keyboard rests, there is a huge range of wrist rests 
available to support the wrist while using the mouse.  All are designed to 
keep the wrist in a relaxed, natural position to avoid discomfort and injury. 

Some mouse pads come with a built in wrist rest as shown at the right. 
 
Chair 

A well designed, adjustable chair is one of the most important factors in preventing posture 
problems.  Your chair should be adjustable vertically (usually between 450 mm and 520 mm in 
height).  The chair should be at a height where you can sit comfortably with both feet on the floor, 
or on a foot-rest. 

The back rest should be adjustable for height and angle.  The back rest should provide support for 
the lumbar region of the back.  

The recommended seat depth is between 380 and 480 mm.  When seated in the chair you should 
be able to fit one hand-width between the seat and the back of your knee. 
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Position in the Chair 

It is important to sit upright in the chair with your back pushed into the backrest, rather than 
slumped forward over the keyboard.  This will reduce the chance of back and shoulder pain.  
When you are seated in your chair ensure you are sitting at the back, not perched at the edge.  
Ensure your feet are flat on the floor or on a footrest, your shoulders are straight and there is a 
slight curve of the spine in the lumbar region. 
 

Foot-rest 

A foot-rest is useful when the desk and chair cannot be adjusted and can 
be used to ensure proper posture.  Ideally the foot-rest slope should be 
comfortable; 0°-10° is recommended, with a flat surface area of 
350 x 45 mm. 
 

Workstation 

A workstation is simply the desk or table used when working on a computer.  The workstation 
should be deep enough to allow the positioning of the keyboard and monitor correctly.  The work 
surface needs to be big enough to allow the mouse, documents, document holder, and any other 
items which are used regularly (telephone, desk caddy, etc) to be within easy reach.  It should also 
be as thin as practical, preferably less than 2.5 cm, to give maximum knee room.  Ideally the 
height of the workstation should be adjustable to suit the height of the operator.  If it is not 
adjustable a foot-rest may need to be used.  

The equipment on the workstation needs to be arranged so that all equipment can be reached 
comfortably.  Frequently-used items should be within easy reach.  A possible workstation layout is 
shown below. 
 
 

 
 

Workstation Location 

The location of the workstation within an office needs to be chosen with care.  The workstation 
should be positioned at right angles to windows, mirrors or other light sources to help reduce glare 
or reflections.  Power cables need to be able to reach the computer safely, without being stretched 
or lying across access ways.  People need clear access to and around the workstation.  In a large 
office, space or partitions between desks can help to give the illusion of having privacy in one‟s 
workspace. 

Localised lighting can be used 
to reduce eye strain. 

Copy-holder positioned 
to side of monitor 

Telephone in easy 
reach 

Mouse and keyboard 
positioned close to user 
so no reaching required  

User can simply turn to 
retrieve documents 
from printer 

Monitor straight in front 
of user 
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Physical Exercises 

There are exercises which, when done regularly, can help to prevent OOS.  These exercises are 
designed to reduce muscle tension and increase blood flow. 

   

Side neck stretch Head turn Bi-directional neck stretch 
Slowly tilt your head to one side, 
stretching the side of your neck.  
Return your head to upright and 
repeat on the other side. 

Slowly turn your head to one side.  
Return to centre and repeat on the 
other side. 

Bend your head forward and then 
turn your head to right.  Use your 
right hand to gently pull your chin 
down towards your armpit.  Repeat 
on the other side. 

   

Shoulder Roll  Upper back stretch Upper arm and shoulder stretch 
Lift both shoulders upward toward 
your ears, and then down again 
slowly.  Roll your shoulders gently 
backwards and forwards to ease 
tension in the neck. 

Clasp your hands behind your head, 
keeping your elbows straight out to 
the side.  Gently lean over the back 
of your chair, stretching your upper 
back. 

Bend your right arm placing your 
right hand on your upper back.  
Hold your right elbow with your left 
hand and use this hand to gently 
push your right arm down.  Repeat 
on the other side. 

   

Chest and shoulder stretch Arm and rib cage stretch Finger Spread 
Interlace your fingers behind your 
back.  Gently turn your elbows 
inwards, straightening your arms. 
Pause and then release. 

Interlock your fingers; stretch your 
arms above your head, palms 
upward.  Try to keep your shoulders 
lowered. 

Hold your right arm out bent upward 
at the elbow.  Spread fingers wide 
apart stretching the inner palm and 
fingers.  Repeat on the other side. 

 

 

 

Chair twist Front wrist stretch Back wrist stretch 
Sit in a chair with your left knee 
crossing your right.  Place your right 
hand on the outside of your left 
knee.  Twist and place your left 
hand on the back of the chair.  Hold 
and repeat on the other side. 

Hold your right forearm out straight, 
palm facing up.  Take your fingers 
with your left hand and pull them 
back gently so the front of your wrist 
is stretched.  Repeat on the other 
side. 

Hold your right forearm out bent 
upward at the elbow.  Take your 
fingers with your left hand and pull 
them gently downward so the back 
of your wrist is stretched.  Repeat 
on the other side. 
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Eye Exercises 
To avoid eye strain when using a computer screen do the following. 

 Blink often to prevent the surface of your eyes drying out and becoming irritated.   

 Stare off into space - every now and then look across the room or out the window. 

 Adjust your screen so it is not too bright. 

 Use a glare screen to minimise glare reflected back into your eyes. 

 Wipe the dust off your screen regularly. 

 Use the clock at the right to practise eye exercises (you can also do 
these exercises in greater movements shown in brackets below). 

12 to 6 (from ceiling to floor) 

9 to 3 (from one side of the room to the other) 

1 to 7 

11 to 5 

Now close your eyes for a few seconds, relax and open your eyes.  Begin at 12 and circle 
around to 3, 6, 9 and back to 12 three times. 

Reverse directions, then close your eyes and relax. 

 To release tension in your face around your eyes, close them tightly and gently squeeze, 
allowing your facial muscles to draw up.  Hold for two seconds, relax your face and open 
your eyes, then open your mouth wide while raising your eyebrows.  Repeat three times. 

 

Work Breaks 
Operators should be given frequent breaks away from their terminals in order to avoid eyestrain 
and posture problems.  The recommended break is 10 minutes every hour worked where work is 
screen-intensive.  Try to vary tasks and take a break from your computer to do filing, make 
business phone calls etc. 
 

Micropauses 
A micropause is a short break in work for muscle relaxation.  Specifically, it is a 5-10 second 
break in work for muscle relaxation every three minutes or so.  Micropauses allow for the 
restoration of blood flow to muscles which have been held tense.  It is when the muscles relax 
fully that micropauses are of most value.  They help you be more productive.  A variation to 
exercises is simply to count your breaths. 
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Starting Microsoft Word 
Exercise 1 

1 Click on the Start button   at the bottom left-hand corner of the screen.    

2 Select  from the Start Menu.  

3 Select  from the Programs menu. 

 

4 Select   from the list to start Word 2010.  
 

Microsoft Word will be displayed on screen with a new document, ready for you to enter text. 
 

 
 
 

 
 
 
 

 

The  tab which contains all basic tasks such as opening, saving and printing a 

document has replaced the Office Button  in Word 2007. 

Microsoft Word 
2010 appears on 
the Start menu after 
you have used it 
three times.  You 
can click on it to 
start Word. 

Ribbon 

Help 

Zoom Controls 

Close 
Quick Access Toolbar 

Vertical 
Scroll Bar 

Vertical 
Scroll Box 

Select 
Browse 
Object 

Title Bar 

File tab 

Minimize Restore Down 

Status Bar 

Insertion point 

Rulers 

 

Group 

 

Tabs 

View 
Ruler 

Note:   
If Rulers are not displayed click 

on the View Ruler button  at 
the top of the Vertical Scroll Bar. 

 

Document Views 

Note 
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Quick Access Toolbar  
The Quick Access Toolbar contains commands to Save, Undo and Redo.  
Frequently used commands can be added to this toolbar.   
 

The Ribbon 
The ribbon in Microsoft Word 2010 is divided into groups and used as described below.  (The 
ribbon replaces menus and toolbars that were used in Word 2003).   
 
(a) When you click on a tab, groups will be displayed relating to that particular feature, eg the 

Home tab displays the groups shown below, ie Clipboard, Font, Paragraph, Styles, Editing. 

 
 

 
 
 

(b) Clicking on a down arrow  displays options for that feature, eg 

clicking on the down arrow at the right of Underline  in the Font 
group displays underlining options as shown at the right.  

(c) Clicking on the Dialog Box Launcher  to the right of the group name 
displays the relevant dialog box, from which you can also select the 
same, and additional options, eg clicking on the Font Dialog Box 
Launcher  displays the dialog box for that group as shown below.  
(Click on Cancel to remove the dialog box.) 

 

 
 

Groups 

 

Tabs 
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Exercise 2 

1 Click on the Orientation down arrow  in the Page Setup group on the Page Layout tab. 

2 Write down the two options that are displayed ...........................................................................  

3 Click to remove options. 

4 Click on the Page Setup Dialog Box Launcher  which displays  ...........................................  
Click on the Margins tab. 

(You will notice there is an Orientation section with the same options as the  button in 
the Page Setup group on the ribbon.) 

5 Click on Cancel.  Click on the Home tab. 
 

 

Exercise 3 
 
1 Type the text shown below onto your screen using the following instructions: 

a To type the heading in uppercase press the Caps Lock key.  Type: ONLINE 

AUCTIONS then press the Caps Lock key to turn off uppercase typing. 

b Press Enter twice to insert a blank line. 

c For an initial uppercase letter, eg the A of An, hold down the Shift key on the opposite 
side of the keyboard to the letter you are going to type, ie hold down the right Shift key, 
type A then release the Shift key.  Continue typing the remainder of the word. 

(The Shift key is also used to type the top symbols on the keys showing two symbols.) 

d Type the remaining text.  Leave any typing errors; you will correct these in Exercise 7.  
Do not press Enter at the end of each line as the text will automatically wrap to the next 
line.  (Enter is pressed once for a new line or twice for a new paragraph.) 

 
 

ONLINE AUCTIONS 
 

An online auction business is a web site where participants bid for products and services 
over the Internet. The process of buying and selling in an auction format is made 
possible through auction software which regulates the various processes involved. 

 
 

 

Saving a document 
Every document you create must be saved with a unique name (called the “file name”) so you can 
recall it to the screen for editing, formatting or printing at a later time.  (Keep file names simple 
and relevant to the document.  You can use letters and numbers, hyphen and underscore.) 
 
Exercise 4 

1 Click on the Save button  on the Quick Access Toolbar  at the top left 
of your screen.  (Note: The Quick Access toolbar may be displayed under the ribbon.) 

 

 

Ctrl S 
 

You can click on the  tab then click on Save. 
 

Tip 

Sa
m

pl
e D

oc
um

en
t

http://en.wikipedia.org/wiki/Product_(business)
http://en.wikipedia.org/wiki/Service_(economics)
http://en.wikipedia.org/wiki/Internet
http://en.wikipedia.org/wiki/Auction
http://en.wikipedia.org/wiki/Auction_software

	US111 v7-107 v6 Word 2010 -Cover
	US111 v7-107 v6 Word 2010 -Copyright
	US111 v7-107 v6 Word 2010 -Downloading Exercise Files
	Changing Defaults Word 2010
	US111 v7-107 v6 Word 2010 -TOC
	US111 v7-107 v6 Word 2010 -1
	US111 v7-107 v6 Word 2010 -2
	US111 v7-107 v6 Word 2010 -3
	US111 v7-107 v6 Word 2010 -4
	US111 v7-107 v6 Word 2010 -5
	US111 v7-107 v6 Word 2010 -6
	US111 v7-107 v6 Word 2010 -Index



